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Abstract  Info Artikel 

The Water Assessment Tool (SWAT) is emerging as an important 

tool for understanding and modeling the complex interactions 

between land, water and vegetation in a watershed. Using this model, 

we can identify areas that are vulnerable to soil erosion, measure the 

impact of certain agricultural practices on nutrients in water, and 

develop more effective water management strategies. It is hoped that 

SWAT modeling can provide in-depth insight into the dynamics of 

hydrology and water quality in the river basins studied, assisting 

decision making in designing sustainable water resource 

management policie. 
 

Abstrak  

Water Assessment Tool (SWAT) muncul sebagai alat penting untuk 

memahami dan memodelkan interaksi kompleks antara tanah, air, dan 

vegetasi dalam suatu Daerah Aliran Sungai (DAS). Dengan 

menggunakan model ini, kita dapat mengidentifikasi area yang rentan 

terhadap erosi tanah, mengukur dampak praktek pertanian tertentu 

terhadap nutrien dalam air, serta menyusun strategi pengelolaan air 

yang lebih efektif. Permodelan SWAT diharapkan dapat memberikan 

wawasan mendalam mengenai dinamika hidrologi dan kualitas air di 

Daerah Aliran Sungai yang diteliti, membantu pengambilan keputusan 

dalam merancang kebijakan pengelolaan sumber daya air yang 

berkelanjutan. 
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1. Pendahuluan 

Pengelolaan sumber daya air dan tanah merupakan 

aspek krusial dalam memastikan keberlanjutan 

lingkungan hidup dan kesejahteraan masyarakat. 

Perubahan iklim, pertumbuhan populasi, dan aktivitas 

manusia yang intensif dapat memiliki dampak 

signifikan terhadap siklus hidrologi dan keseimbangan 

air tanah di suatu daerah. Dalam konteks ini, Soil and 

Water Assessment Tool (SWAT) muncul sebagai alat 

penting untuk memahami dan memodelkan interaksi 

kompleks antara tanah, air, dan vegetasi dalam suatu 

Daerah Aliran Sungai (DAS). SWAT menyediakan 

kerangka kerja yang komprehensif untuk mengevaluasi 

dampak perubahan lahan, praktek pertanian, dan faktor-

faktor lainnya terhadap kualitas air dan kuantitas air di 

suatu wilayah.  

Penelitian ini bertujuan untuk mengaplikasikan dan 

menganalisis model SWAT dalam konteks spesifik 

yang relevan dengan tantangan lingkungan dan 

kebutuhan pengelolaan sumber daya air di daerah 

tertentu. Dengan menggunakan model ini, kita dapat 

mengidentifikasi area yang rentan terhadap erosi tanah, 

mengukur dampak praktek pertanian tertentu terhadap 

nutrien dalam air, serta menyusun strategi pengelolaan 
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air yang lebih efektif. Permodelan SWAT diharapkan 

dapat memberikan wawasan mendalam mengenai 

dinamika hidrologi dan kualitas air di Daerah Aliran 

Sungai yang diteliti, membantu pengambilan keputusan 

dalam merancang kebijakan pengelolaan sumber daya 

air yang berkelanjutan. Oleh karena itu, pemahaman 

mendalam tentang SWAT dan aplikasinya di dalam 

ArcGIS merupakan langkah penting dalam mendukung 

penelitian dan upaya pengelolaan sumber daya air di 

DAS Kabupaten Lebak yang lebih efisien dan efektif. 

 

2. Metode  

Soil dan Water Assesment Tool (SWAT) 

Model Hidrologi merupakan model matematik 

yang digunakan untuk mensimulasikan water balance 

dalam suatu DAS. Keluaran dari model hidrologi 

diantaranya ketersediaan air, sedimentasi, dan polutan 

(Sukma & Wardhana, n.d.). Ada beberapa model 

untuk simulasi hidrologi berdasarkan proses hidrologi, 

diantaranya yaitu SWAT. SWAT atau Soil Water 

Assesment Tools adalah model permodelan hidrologi 

yang digunakan untuk mensimulasikan siklus air, 

sedimentasi, dan polutan di suatu daerah sungai atau 

cekungan. Model ini membantu dalam memahami dan 

mengelola sumber daya air dan tanah.  

Model SWAT merupakan pengembangan dari 

model SWRRB (Simulator for Water Resources in 

Rural Basins) pada tahun 1980 oleh USDA. Sampai 

dirilisnya pada tahun 2005, SWAT telah mampu 

mensimulasikan total run-off untuk banyak subDAS, 

menghitung aliran air tanah dan sedimentasi sebaik 

perhitungan polutan untuk kegunaan pertanian 

(KURNIADI, 2021).oil and Water Assessment Tools 

(SWAT) dapat diartikan sebagai seperangkat alat atau 

metode yang digunakan untuk mengevaluasi dan 

menganalisis sumber daya tanah dan air di suatu 

daerah atau wilayah tertentu. Alat ini dirancang untuk 

membantu dalam pemahaman dan manajemen 

berbagai aspek lingkungan, terutama terkait dengan 

tanah dan air.  

SWAT biasanya digunakan untuk melakukan 

analisis hidrologi dan erosi tanah, mengidentifikasi 

pola aliran air, memprediksi kualitas air, dan 

merancang strategi manajemen sumber daya alam. 

Alat ini menggabungkan model matematika yang 

kompleks dengan data spasial dan atribut fisik dari 

suatu daerah untuk menyajikan informasi yang 

berguna bagi para pengambil keputusan di bidang 

pertanian, lingkungan, dan pengelolaan sumber daya 

alam. Penting untuk dicatat bahwa definisi ini dapat 

bervariasi tergantung pada konteks dan penggunaan 

spesifik dari Soil and Water Assessment Tools dalam 

suatu proyek atau riset tertentu. 

Simulasi SWAT memiliki 2 tahap, yaitu 

preprocessing   SWAT dan Processing SWAT  

1. Preprocessing SWAT  

a. Watershed delination, menghitung besaran 

akumulasi aliran dan arah aliran melalui 

topografi 

b. Overlay HRU, tutupan lahan, jenis tanah, 

kemiringan lereng di klasifikasi ulang ulang 

ke dalam standar SWAT berdasarkang 

karakteristik dan penamaan. 

c. Weather generator, seperti data curah hujan, 

data radiasi, data suhu, data kelembaban, dan 

data kecepatan angin sebagai input data 

dengan format *.txt atau *.dbf, 1 file 

merepresentasikan 1 stasiun dan nama sasiun 

menjadi nama stasiun tersebut. 

d. Run SWAT dan Read SWAT Output 

2. Procesing SWAT 

Data preprocessing dipakai untuk perhitungan 

model SWAT. Output dari SWAT adalah Flow 

(streamflow), Groundwater Flow (BaseFlow), Direct 

Run-off, Water yield (total run-off), sedimentasi dan 

polutan. Setelah simulasi selesai, selanjutnya adalah 

proses kalibrasi dengan membandingkan debit SWAT 

dan observasi dalam waktu dan tempat yang sama. 

Secara kulaitatif dilakukan perbandingan dengan 

memperhatikan puncak hidrograf, fase, dan baseflow. 

Kalibrasi SWAT dibagi menjadi 3 bagian (Arnold, 

dkk., 2011), diantaranya 

a. Adjustment Curve number for direct run-off 

or hydrograph peak 

b. Adjustment Gw_revap for baseflow 

c. Adjustment Alpha-BF for time lagging 

 

Data Processing SWAT 
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Data yang digunakan dalam permodelan swat ini 

adalah:  

a. Data DEM  

b. Data Landuse.  

c. Data curah hujan, temperatur maksimum-

minimum, kelembaban, radiasi matahari, dan 

angin.  

d. Data jenis tanah.  

 

3. Hasil dan Pembahasan 

Langkah-Langkah Penelitian 

a. Persiapan Awal 

1) Install terlebih dahulu ArcSWAT sesuai 

dengan versi ArcGIS yang digunakan 

2) Setelah terinstall, pilih toolbar kosong 

dengan klik kanan dan centang pilihan 

ArcSWAT 

3) Buat folder connection sesuai dengan 

tempat penyimpanan data 

4) Buat project baru SWAT dengan klik 

SWAT Project Setup 

5) Pada bagian Project Directory pilih 

folder connection tempat penyimpanan 

data --> kemudian rename nama project 

nya --> pastikan SWAT Parameter 

Geodatabase nya berada pada folder 

connection yang digunakan --> OK 

6) Setelah itu akan muncul dialog Project 

setup is done 

7) Tahap persiapan Selesai 

Pembuatan DAS 

a. Input data yang digunakan pada folder 

connection, yaitu data sungai 

b. Klik Watershed Delineator > Automatic 

Watershed Delineator 

c. Klik DEM Project Setup > Ganti Z unit 

menjadi Meter 

d. Centang bagian Burn In >Klik ikon folder > 

Select from Map > pilih Sungai (bukan sungai 

RBI) 

e. Setelah selesai maka akan muncul tampilan 

berikut: 

 

Gambar 1. Tampilan Hasil Delineasi DAS 

f. Jangan lupa simpan hasil delineasi DAS, klik 

SWAT Project Setup --> Save SWAT Project. 

Delineasi DAS sudah selesai. 

HRU Analysis (Hydrologic Response Unit)  

a. Input data tanah dan tata guna lahan. Klik ikon 

add data (file > add data), kemudian muncul 

tampilan berikut, pilih soil dan landuse 

b. Pada bagian Choose Grid Field pilih Value > 

OK > Pilih UserSoil > maka akan muncul 

SWAT Land Use Classification Table 

c. Klik dua kali pada bagian Name (kolom 

kosong) yang berada pada SWAT Soil 

Classification Table dan cocokkan antara 

kolom VALUE sesuai dengan swatid pada 

data excel yang telah dicopy 

d. Setelah semua baris pada kolom Name terisi 

klik Reclassify > muncul Soils reclassify 

completed! > OK 

e. Masih di jendela Land Use/Soils/Slope 

Definition > klik tab Slope 

f. Pilih Single Slope untuk menyederhanakan 

perhitungan slope > klik Reclassify > akan 

muncul Slope reclassify complete! > OK 

g. Kemudian klik Overlay > tunggu sampai 

prosesnya selesai > akan muncul Finished 

Land Use/Soils/Slope Definition > OK 

h. Klik HRU Analysis > HRU Definition > pilih 

Multiple HRUs > pilih Percentage > isikan 

masing-masing kategori dengan nilai 10% > 

klik Create HRUs > akan muncul Completed 

HRU definition > OK 

i. Jangan lupa simpan hasil delineasi DAS, klik 

SWAT Project Setup > Save SWAT Project 
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j. HRU Analysis sudah selesai 

Input Data Weather Station 

a. Sebelum melakukan input data cuaca, hal 

yang harus dilakukan adalah menyiapkan data 

Rain fall, Temperature, Solar radiation, 

Relative humidity (RH), dan Wind speed. 

Data tersebut dapat di download pada 

halaman globalweather.tamu.edu dan 

sesuaikan dengan lokasi lon lat daerah kajian 

serta waktu kajian 

b. Setelah data dari global weather terdownload, 

update database WGEN sesuai dengan jumlah 

stasiun pengamatan cuaca di daerah kajian 

c. Pada folder data (Sample Data) terdapat file 

SWAT2012.mdb > buka file tersebut > pilih 

bagian WGEN 

d. Terdapat 4 stasiun pada data WGEN, perlu 

diupdate sesuai dengan jumlah stasiun pada 

data global weather (6 stasiun) 

e. Export data WGEN tersebut kedalam excel. 

Klik menu External Data > Export > Excel 

Spreadsheet > pilih lokasi penyimpanan > 

Centang 2 pilihan teratas dari Specify Export 

Option > OK 

f. Kemudian masukkan data dari global weather 

tersebut sesuai dengan stasiun yang dikaji ke 

dalam data excel WGEN 

g. Setelah semua data di excel terisi dengan 

lengkap, simpan file WGEN.xlsx tersebut 

pada folder Sample data 

h. Import file WGEN ke dalam file database 

SWAT2012. Klik menu External Data > 

Excel > pilih file dan lokasi penyimpanan > 

OK. Kemudian akan muncul jendela Import 

Spreadsheet Wizard > klik Next > Next lagi > 

pada bagian berikut ini, pilih No primary key 

> Next lagi > Finish 

i. Jangan lupa disimpan file SWAT2012.mdb 

j. Kembali ke jendela arcGIS > klik Write Input 

Table > Weather Station > klik tab Weather 

Generator Data > pada kotak Locations Table 

pilih dan akan terlihat jumlah stasiun 

cuacanya adalah 6 

Input Data Weather Station 

a. Untuk menjalankan Model SWAT klik 

SWAT Simulation > Run SWAT > pastikan 

pada bagian Setup and Run SWAT Model 

Simulation periode waktunya benar dan diatur 

sesuai dengan kebutuhan 

 

Gambar 2. Run SWAT Check 

b. Untuk melihat hasil simulasi Model SWAT 

yang telah dilakukan klik SWAT Simulation 

> Read SWAT Output > ceklis bagian 

output.rch dan output.sub > klik Import Files 

to Database > akan muncul Done writing files 

to database! > OK 

c. Data hasil running Model SWAT dapat 

diimport ke dalam database 

d. Simulasi Model SWAT selesai 

 

4. Simpulan 

Kesimpulan untuk simulasi permodelan Soil Water 

Assessment Tool (SWAT) dapat disusun berdasarkan 

hasil analisis dan evaluasi keakuratan model SWAT 

terhadap data pengukuran lapangan menunjukkan 

tingkat validitas yang memadai. Kesesuaian hasil 

simulasi dengan data observasi memberikan 

keyakinan terhadap kemampuan model dalam 

merepresentasikan kondisi nyata di lapangan. 

Simulasi model SWAT mampu mensimulasikan 

siklus air tanah dengan baik, mencakup distribusi air 

tanah dan interaksi dengan tanaman. Simulasi 

menghasilkan prediksi yang konsisten dan mendekati 

kondisi sebenarnya selama periode waktu tertentu. 

Hasil simulasi dapat diaplikasikan secara praktis untuk 

mendukung pengelolaan sumber daya air dan 

pertanian di daerah studi.  
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Mengidentifikasi keterbatasan model SWAT dan 

faktor-faktor yang mempengaruhi ketidakpastian hasil 

simulasi. Dan memberikan rekomendasi untuk 

perbaikan model atau pengumpulan data tambahan 

yang mungkin diperlukan untuk meningkatkan 

ketepatan hasil terhadap metode permodelan, 

interpretasi hasil, dan implikasi praktisnya. Selain itu, 

memberikan pandangan yang seimbang mengenai 

kekuatan dan keterbatasan model SWAT serta arah 

pengembangan yang mungkin diperlukan untuk 

penelitian mendatang.  
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